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Gaia is a system that enables rapid and 

precise creation of gorgeous looking Unity 
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Gaia by Procedural Worlds 

Welcome! 
 

Thank you for purchasing Gaia!  

Gaia is a sophisticated tool with a lot of options and while you can go as deep as 

you like to create fully customized environments, you can also start easily and 

quickly. 

To get up and running as fast as possible, please follow this quick start guide. We also 

have a range of guide articles and tutorials on our website. You can also find more 

information in  our knowledge base at 

https://proceduralworlds.freshdesk.com/support/solutions. 

 

Help / Documentation System: This quickstart guide is only a first introduction on how 

to use Gaia. Most of Gaia’s documentation can be found in the help system directly 

on the User Interface. This saves you opening a manual document or website while 

working with the application. 

Look for  a question mark help button in the top right corner:   

  

Clicking this button will display additional information on the UI, providing help for 

the input fields.  

https://procedural-worlds.com/support/tutorials/
https://proceduralworlds.freshdesk.com/support/solutions
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If you are not sure what a certain option in Gaia does, the help system would be the 

first place to check. For more complex tools or workflow information, the system 

offers links to online help pages in the Procedural Worlds Knowledge Base. 

 

 

Also note that all input fields use tooltips as well that you can see when hovering the 

mouse over the name of the input field: 

 

 

 

PRO TIP:  

 

Did you know that we also have a range of other products to enhance your 

environments in Unity? For example, with Gaia you can now use SECTR to stream 

large multi tile worlds - with massive performance increases! 

 

 

Check out our other products on the next page to learn more! 

  

https://proceduralworlds.freshdesk.com/support/solutions
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About Procedural Worlds 
 

At Procedural Worlds we create quality products that are easy to use, nicely 

integrated and well supported. We document our products and help you to get the 

best out of them and Unity with over 100 video tutorials on our YouTube channel. 

Your investment supports our team so that we can create better products sooner 

and provide you with timely support now. To learn more about us please check out 

our reviews and then come and say hello or chat with other members of the 

community on our discord channel. 

 

Please Note: The links used in this section are affiliate links that will grant us an extra 

revenue share if you decide to make a purchase. Please consider buying via these 

links if you want to support us in what we are doing even beyond your purchase. 

 

Our World Creation Products 

 
Gaia - A world and scene generation system for creating, texturing, planting and 

populating scenes from low poly mobile, VR and through to high end desktop. 

 

GeNa 2 - Nominated by Unity as one of the best assets of 2018, GeNa 2 is a 

sophisticated level design tool that augments Gaia’s broad brush strokes, by working 

intuitively to give fine grained control in the placement of assets into your scene. 

 

Path Painter - A tool to make terrain based roads, ramps, paths, and river creation 

and texturing a breeze. 

 

CTS 2019 - Nominated by Unity of as one of the best assets in 2017, a PBR terrain 

shading system that significantly improves terrain look, performance and usability. 

 

SECTR Complete 2019 - A suite of performance-enhancing tools that enable open 

world streaming, massive mobile games and includes the latest techniques in audio 

occlusion and propagation. 

 

Our World Enhancement Products 
 

Ambient Sounds - A tool that creates interactive soundscapes that also comes with 

professionally composed sound effects and music library. 

 

Ambient Skies - An integrated Skies, Post FX and Lighting system that makes it easy to 

create visually beautiful scenes. 

Real Ivy 2 – An awesome procedural ivy and plant generation system. 

 

World Manager API - A FREE light weight command and control system for Unity 3D 

that manages all your environmental assets via one simple API. 

http://www.procedural-worlds.com/
https://www.youtube.com/user/btektube
https://discord.gg/TggjQNN
https://assetstore.unity.com/packages/tools/terrain/gaia-terrain-scene-generator-42618?aid=1101lSqC
https://assetstore.unity.com/packages/tools/terrain/gena-2-terrain-scene-spawner-127636?aid=1101lSqC
https://assetstore.unity.com/packages/tools/terrain/path-painter-127506?aid=1101lSqC
https://assetstore.unity.com/packages/tools/terrain/cts-2019-complete-terrain-shader-140806?aid=1101lSqC
https://assetstore.unity.com/packages/tools/terrain/sectr-complete-2019-144433?aid=1101lSqC
https://assetstore.unity.com/packages/tools/audio/ambient-sounds-interactive-soundscapes-142132?aid=1101lSqC
https://assetstore.unity.com/packages/tools/particles-effects/ambient-skies-skies-post-fx-lighting-145817?aid=1101lSqC
https://assetstore.unity.com/packages/tools/modeling/real-ivy-2-procedural-ivy-generator-155841?aid=1101lSqC
http://www.procedural-worlds.com/blog/wapi/
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Our Utilities 
 

Pegasus - A system that can drive anything along a path. Great for cutscenes, and 

even has an intelligent driver that drives characters, formations, animation and even 

has local avoidance for your npcs and animals! 

 

Learn more at our website here: http://www.procedural-worlds.com/ 

 

https://assetstore.unity.com/packages/tools/animation/pegasus-65397?aid=1101lSqC
http://www.procedural-worlds.com/
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Tutorials, Chat, Ticketed Support 
 

Still stuck even after reading the quickstart guide? You can talk to other members of 

the community on our discord server: https://discord.gg/TggjQNN 

 

Or you can post on the Gaia Unity Forum thread: 

https://forum.unity.com/threads/gaia-aaa-terrain-generator-procedural-texturing-

planting-and-scene-creation.327342/ 

Or lodge a Support Request with our customer support: 

https://proceduralworlds.freshdesk.com/support/home 

 

Migrating from Gaia 1 
 

Gaia 1 and Gaia 2 / Pro are not directly upwards compatible - but it is possible to 

migrate scenes that were created with Gaia 1 into Gaia 2 / Pro so that you can 

continue working on your terrain with the more advanced tools. Please visit this 

page for information on how to migrate from Gaia 1: 

 

https://proceduralworlds.freshdesk.com/support/solutions/articles/33000252032-

migrating-a-gaia-1-scene-to-gaia-2-pro 

 

 

 

 

  

https://discord.gg/TggjQNN
https://proceduralworlds.freshdesk.com/support/home
https://proceduralworlds.freshdesk.com/support/solutions/articles/33000252032-migrating-a-gaia-1-scene-to-gaia-2-pro
https://proceduralworlds.freshdesk.com/support/solutions/articles/33000252032-migrating-a-gaia-1-scene-to-gaia-2-pro
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Setup  
 

Before you start out with Gaia, please look through these steps to make sure Gaia is 

correctly installed in your project. While these instructions may seem long, the most 

text here is more informational, the actual doing is just a few clicks.  

1. Create a new project in Unity or open the project that you want to use 

Gaia in. 

 

2. <OPTIONAL> In most cases you want to work in linear colour space, and it 

can save you a lot of time to switch the colour space to “Linear” in your 

project before importing Gaia (or any other unity package). By doing so, 

the included assets will be imported in the correct colour space settings 

right away (as opposed to being re-imported again when switching the 

colour space later) 

 

To find out more about colour space please read the official information 

from Unity about this topic and decide which colour space you want to 

use. Unless you are developing for Mobile or VR or have very special 

requirements, you usually want to choose linear colour space. 

 

To switch colour space, open 

Edit > Project Settings > Player 

and adjust the colour space under “Other Settings” 

 

 

Don’t worry if you are unsure about this setting – you can always change 

the colour space later in your project, but processing this change then 

https://docs.unity3d.com/Manual/LinearRendering-LinearOrGammaWorkflow.html
https://docs.unity3d.com/Manual/LinearRendering-LinearOrGammaWorkflow.html
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can take a while. 

 

3. Install Gaia from the Asset Store Window or the Package Manager (in Unity 

versions 2020 and above). If you are not familiar with using the asset store 

from inside the unity editor, please see these instructions. 

Please note that with Unity 2020 and higher the Asset Store Window has 

been removed, and you need to download asset store content via the 

package manager now. 

 

<OPTIONAL> For a better experience with Gaia in the built-in rendering 

pipeline it is recommended to install the Post Processing Package from the 

package manager. This is entirely optional – Gaia will work fine without 

post processing installed, but then can’t set up post processing in your 

scene, for underwater effects or in your biomes.  

 

This optional step is also not required when using HDRP or URP as these 

rendering pipelines come with their own version of post processing 

automatically. 

 

To install post processing in your project, please open the package 

manager from Window > Package Manager and locate and install the 

post processing package: 

 

 
 

 

 

4. Your entry point to using Gaia is the Gaia Manager Window. After 

importing Gaia from the asset store, you can open the Gaia Manager 

Window from the Window Menu or by pressing Control + G: 

https://docs.unity3d.com/Manual/AssetStore.html
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When the Gaia Manager is being opened for the first time after a new 

installation or an update, it will perform an initial maintenance / setup 

process which runs by itself. 

 

If the Gaia Manager Menu entry does not appear: In 99% of the cases this 

is caused by compilation errors in the project. Please check your console 

for messages that might prevent the successful compilation of your 

project. In a fresh project this is very unlikely to happen, but in a larger, 

living project these errors can have many different causes. If you are stuck 

with a compilation error that you can’t resolve, please contact support. 

 

5. In the Gaia Manager, the Setup Tab will be selected if your project is not in 

linear deferred rendering mode. It will offer a button to correct this.  

 

 
 

(Set Linear Deferred Rendering) click this to set your project’s colour space 

linear and your rendering path to deferred in order to get the best visuals 

and performance. This step only ever has to be done once in your project. 

If you performed the switch to linear before as mentioned in Step 2 this 



 

Gaia by Procedural Worlds 

process will be very fast, otherwise it might take a bit to reimport the assets. 

 

NOTE: If you are using gamma colour space you can ignore this step! 

 

6. <OPTIONAL> Gaia comes with its own water and vegetation shaders 

which also support the Unity scripted rendering pipelines (SRPs). These are 

commonly known under the terms  

 

HDRP – High Definition Rendering Pipeline 

LWRP – Lightweight Rendering Pipeline 

URP – Universal Rendering Pipeline 

 

If you want to use one of these Pipelines, you need to set up Gaia for that 

specific pipeline. If you want to use Unity’s built in rendering, you are done 

with setting up Gaia already. 

Supporting these pipelines can be challenging for asset store developers 

as we need to make sure that features like water use the correct shader 

for the correct pipeline for the correct unity / SRP version. To make this 

easier for you, we have mostly automated this process in the Setup Tab in 

the Gaia Manager: 

 
 

In this panel you need to do only two things: 

 

A) If you want to use a different pipeline than built-in rendering, select the 

pipeline you want to use and click the button to upgrade Gaia to this 

pipeline. This will change the Gaia tools and functions to the respective 

pipeline. This process can be reverted later as well. If you want to use built-

https://docs.unity3d.com/Manual/ScriptableRenderPipeline.html
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in rendering only, you don’t need to do perform this step, Gaia is pre-

configured for built in rendering after import already. 

 

B) After you configured the rendering pipeline, click the “Install Shaders” 

button. This will install the shaders for both the water and the vegetation 

for the correct unity version and the pipeline you selected above. If the 

correct shaders are already installed, this button will not appear. 

 

 
 

The Gaia setup process  is now done. 

 

Please note: Using the SRPs is not recommended for Unity beginners as 

using those pipelines come with their own challenges and limitations you 

need to master. Doing so while just starting out with Unity will make your 

journey more difficult than it needs to be.  

If you decide to use the SRPs please note that all materials you use 

beyond the Gaia vegetation items and the water need to be compatible 

with your target pipeline. Gaia cannot set up materials from other asset 

packs or convert shaders written for a different pipeline automagically for 

you. 

 

When you are switching pipelines it is possible to revert back to built-in 

rendering later and then switch to another pipeline again.  
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Create your first terrain with Gaia – in just a few clicks! 
 

In this scenario we will use Gaia to generate an entire new scene using a simple 

heightmap stamp and a biome preset – this will create an entire terrain for you in just 

a few minutes. 

 

1. Create a new scene. To create a new scene, select File -> New Scene or 

Ctrl + N.  
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2. In your new scene, open the Gaia Manager by pressing Ctrl + G or the 

Window / Procedural Worlds / Gaia / Show Gaia Manager... menu entry. 

 

Creating a scene with Gaia can be divided in 4 steps which are 

represented as tabs in the Gaia Manager as well:  

 

 
 

1. Create Terrains that represent the surface area of your world 

2. Use the Gaia Tools to sculpt the terrains and populate them with 

textures, trees, etc. 

3. Create Runtime settings such as Lighting, Water, a Player to explore the 

terrain…. 

4. <Optional> Run Light Baking in your scene to bake lighting and 

reflection probes etc.  

 

In a new scene, the Terrain tab is selected per default. Here you can set 

up settings for your world size and the visual world quality. 

 

For your first attempt the default settings in here should be fine – you can 

always start this process over to select a different terrain size or quality 

options later. If you are curious, you can click the small “+” buttons to see 

the advanced world size or quality options.  

Click on “Create Terrain(s)” to create the terrains and to move to the next 

tab. 
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3. You should see a new terrain being added to the scene, and the Gaia 

Manager will switch forward to the tools tab.  

 

In the tools tab you have the option to add a stamper to the scene – the 

stamper is the Gaia tool that allows you to sculpt your terrain by raising or 

lowering parts of it to form mountains, valleys, etc. For the sake of the 

quickstart guide you would need to leave that enabled.  

You can also select a biome settings file to use in your world – A biome is a 

collection of spawners that populate your terrain with resources such as 

textures, trees, grass etc. Resources that fit well together can be grouped 

up in a biome so you can apply the same style of assets to different 

terrains. It is also possible to spawn biomes only in certain areas of the 

world which means you can create different looks in different regions of 

your terrain. 

 

As with the terrain creation tab the default settings are fine for our 

purpose, so you can click “Create tools” to create a stamper and your first 

biome in the scene. 

 

Gaia will then create the stamper and the biome, and then select the 

stamper tool. You can now consider closing down the Gaia Manager, 

since you will most likely want an unobstructed view of the stamper in your 

scene.  

The blue-greenish terrain you see in the scene view now is not your final 

terrain just yet – it is more a real-time preview of the terrain shape we are 

about to create. You should also see a stamp browser window which 

allows you to quickly select one of the stamps (“terrain shapes”) that 

come with Gaia. 
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4. To get a first impression on how the stamper and the preview works, try 

selecting a different stamp in the stamp browser by using the back and 

forward buttons and / or selecting a different stamp category. The 

stamper preview in the scene view should update immediately with your 

selection. Try to find a stamp that appeals to you, ideally it also allows a bit 

of water in the scene (deep blue in the preview) to be visible as well. 

 

 

 

When you are happy with the selected stamp, you can click “Apply”. 

 

5. In the unity inspector you should have the stamper controls selected. Click 

“Stamp” at the very bottom of the Stamper to apply the selected stamp 

to the terrain.  
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The following is happening now: 

 

 

 

- The stamper adjusts the heightmap on the terrain to form mountains and 

valleys according to the stamp you selected 

 

- When stamping is done, per default a texture spawner will apply textures 

to the terrain so you can estimate better what the outcome of applying 

this stamp is (having a rock texture on a mountain, grass on plains etc. 

makes the terrain easier to read). 
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You can repeat this process while moving the stamp around and / or 

selecting different stamps from the stamp selector window to stamp 

additional features on the terrain. When you are satisfied with the result, 

you can look for the “Spawn Biome” button that will place the remaining 

other assets (grass, tree, game objects) from the biome on the terrain: 

 

 
 

This button is just a shortcut for selecting the biome in the scene hierarchy 

and running the spawn from there: 
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You can either press the “Spawn Biome” button in the stamper or navigate 

to the biome and start the biome spawn from there. 

 

 
 

When the progress bar in the centre of the screen disappears and the 

inspector window becomes active again, the biome spawning process is 

complete. Zoom in in the scene view a bit and you should be able to see 

trees and grass on the terrain.  
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Now that you got your first terrain, let’s take the next step to add runtime 

settings to your scene. 

 

6. Bring up the Gaia Manager Window again. It should automatically select 

the runtime tab since you already executed the first two steps of the 

scene creation process. 

 

 
 

 

This tab shows you the available runtime elements such as Lighting or 
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Water that you can add to your scene. Unlike the Gaia Tools, these 

elements are intended to remain in your final product. You can take a 

look at the available settings and choose what you want to add to your 

scene, again the default settings should be fine for the purpose of this 

guide. Click on “Create Runtime” to add the elements to the scene. 

 

You should notice a huge visual upgrade due to the added sky, lighting 

and water in your scene, especially if you have post processing enabled. 

 

 

 

 

7. At this point your scene is now fully usable and you can click play to see it 

in action. Depending on the selected player type you can fly / wander 

through the scene with the usual WASD + mouse controls. 
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If you selected the screenshotter tool for the runtime setup, you could 

press F12 to make screenshots which will be saved inside the Gaia User 

Data folder. 

 

8. The last (and optional) step is light baking. If you are unsure what light 

baking is and if you want to use it, you can read more about light baking 

in the Unity manual. 

You can still bake the lighting in your scene just as you would without Gaia, 

but Gaia offers some additional functionality that makes light baking on a 

terrain easier. 

 

 
 

In the remaining Tab in the Gaia Manager you can find controls for 

spawning both light and reflection probes across the terrain in a grid 

pattern – this saves a lot of time in comparison to setting those probes up 

manually. You can bake those probes by clicking “Full Lightmap Bake” 

which will trigger the unity light baking process. 

 

If you are not that interested in using light baking it is still recommended to 

at least click the “Quick Lightmap Bake” button. This button will populate 

the global reflection and light probe data for the scene which is very 

quick and allows for basic reflections will give your ambient lighting a more 

accurate colour tone. 

 

This concludes the Gaia Quickstart Guide. 

 

Please Note: This was only the quickest possible introduction to Gaia and 

we skipped a lot of the steps that a more experienced user would take in 

Gaia, e.g. a more detailed terrain sculpting process, and building their 

own set of spawners according to their design goals. 

You are not restricted to using a single stamp and then having to live with 

the result Gaia generates – You can use multiple stamps to form your 

terrain and control every aspect of the spawning process to populate the 

terrain so you can get exactly the result you want. 

https://docs.unity3d.com/Manual/Lightmappers.html
https://docs.unity3d.com/Manual/Lightmappers.html
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Of course you can also add your own assets to Gaia to spawn them on 

your terrain in the same fashion as shown in this quickstart guide. 

 

Where to go from here – Next steps 

 
If you have worked your way through the quick start guide, it is recommended to 

start over but this time around take a deeper look at the individual tools at hand 

and the features that they provide to flesh out your scene. Remember that the 

question mark help button provides help directly in the application and links you to 

more detailed manual articles in our knowledge base where appropriate. If you 

want to follow more tutorials before experimenting on your own, you can visit the 

Tutorials Collection on the Procedural Worlds website. The Knowledge Base is also a 

good starting point when you want to read more about the individual Gaia Tools 

before continuing your journey. 

 

Gaia GX - (G)aia e(X)tensions 

 
The Gaia extensions system allows Gaia to be extended with other tools and quality 

assets. 

 

We used the Gaia Extension system to include our own sky and water system so that 

you can change the sky and water setup and surrounding settings from this menu as 

well. 

 

To access them, go to the GX tab in Gaia Manager and select Procedural Worlds, 

https://procedural-worlds.com/support/tutorials/
https://proceduralworlds.freshdesk.com/support/solutions
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Skies and Water to modify your time of day, water and post processing settings.  

 

When you select a sky the sun light will be reconfigured, fog colour, density will be 

changed and the skybox. Also, the post processing profile will be changed to the 

appropriate time of day to give the best experience.  

 

You can also add and remove the water with also using a few of the preset 

configurations on the material settings. Lastly you can configure the post processing 

profiles to change them although these dynamically change when you select your 

time of day. 

 

Adjusting the ambient audio volume  
 

In the Hierarchy under Gaia Lighting Environment is the Ambient Audio game object. 

Click on that and then in the Inspector adjust the Volume.  

 

Why you need to bake your lighting  
 

Lightmaps are very important as they store the information than the Unity GI system 

needs to light your scene properly.  

 

If you are using a skybox and an ambient light source you will not see any ambient 

lighting in your scene until your lighting is baked. Distance shadow masking for game 

objects and terrain won't be correct until you bake your scene lighting. You can 

have both baked and real time lightmapping in your scene also known as mixed 

lighting. Most large projects mix both baked and real time lighting. To learn more 

about light baking and lighting in general, please visit these links: 

 

https://unity3d.com/de/learn/tutorials/topics/graphics/choosing-lighting-technique 

 

https://blogs.unity3d.com/2018/03/09/spotlight-team-best-practices-making-

believable-visuals-in-unity/ 

 

Pipeline Switching 
 

If you need to switch rendering pipelines before starting a new project or during an 

existing project, you can do so via the “Setup” panel in the Gaia Manager window. 

Please see the installation information at the beginning of this guide for more 

information. 

 

https://unity3d.com/de/learn/tutorials/topics/graphics/choosing-lighting-technique
https://blogs.unity3d.com/2018/03/09/spotlight-team-best-practices-making-believable-visuals-in-unity/
https://blogs.unity3d.com/2018/03/09/spotlight-team-best-practices-making-believable-visuals-in-unity/

